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Using This Guide

Congratulations on your purchase of an Avid® Active ContentManager system. It is one of 
the latest advances in new digital asset management and distribution, making it the ideal 
solution for broadcast and media organizations.

It is a prepackaged Web content management solution, which enables broadcasters to 
maximize their return on their media assets for distribution on their existing Web 
infrastructure without duplicating production efforts.

n The documentation describes the features and hardware of all models. Therefore, your 
system might not contain certain features and hardware that are covered in the 
documentation.

Symbols and Conventions

Avid documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

n A note provides important related information, reminders, 
recommendations, and strong suggestions.

c A caution means that a specific action you take could cause harm to 
your computer or cause you to lose data.

w A warning describes an action that could cause you physical harm. 
Follow the guidelines in this document or on the unit itself when 
handling electrical equipment.

> This symbol indicates menu commands (and subcommands) in the 
order you select them. For example, File > Import means to open the 
File menu and then select the Import command.

Italic font Italic font is used to emphasize certain words and to indicate variables.

Courier Bold font Courier Bold font identifies text that you type.

Bold font Bold indicates a user interaction.
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If You Need Help

If you are having trouble using Avid Active ContentManager:

1. Retry the action, carefully following the instructions given for that task in this manual. It 
is especially important to check each step of your workflow. 

2. Visit the online Knowledge Base at www.avid.com/onlinesupport. Online services are 
available 24 hours per day, 7 days per week. Search this online Knowledge Base to find 
answers, to view error messages, to access troubleshooting tips, to download updates, 
and to read/join online message-board discussions.

Documentation

The following documents provide more information about Active ContentManager:

• Avid Active ContentManager Read Me provides installation, administration, and 
user-level information that may not have been available at the time other documentation 
was printed.

• Avid Active ContentManager SDK User Manual is an HTML-based document that 
provides user-level information for the Object Manager and System Manager 
applications.

To order additional copies of the printed documentation from within the United States, call 
Avid Sales at 800-949-AVID (800-949-2843). If you are placing an order from outside the 
United States, contact your local Avid representative.

Contact your Avid Sales representative for documentation and information on other Avid 
products, such as Avid Unity™, Avid iNEWS® newsroom computer system, Avid 
AirSPACE™ video servers, Avid Media Browse™, and Avid NewsCutter®.

http://www.avid.com/onlinesupport
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Avid Training Services

Avid makes lifelong learning, career advancement, and personal development easy and 
convenient. Avid understands that the knowledge you need to differentiate yourself is always 
changing, and Avid continually updates course content and offers new training delivery 
methods that accommodate your pressured and competitive work environment.

To learn about Avid's new online learning environment, Avid Learning Excellerator 
(ALEX)TM, visit http://learn.avid.com.

For information on courses/schedules, training centers, certifications, courseware, and 
books, please visit www.avid.com/training or call Avid Sales at 800-949-AVID 
(800-949-2843).

http://learn.avid.com
http://www.avid.com/training
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1 Introducing the Active ContentManager

We are living in a world where everyone is using the web to get up-to-the-minute news from 
politics to entertainment. It is key that news producers such as journalists, editors, and 
webmasters be provided with efficient tools to get stories, videos, and images to the web as 
soon as a story breaks. 

Active ContentManager (ACM) is a powerful web-based application that lets news 
producers create, manage, and publish news stories to the web and on delivery platforms 
such as mobile phones and hand-held devices with widgets such as Google or Yahoo.

You will find the following information:

• ACM in the Newsroom

• ACM Workflows

• Who are Active ContentManager Users?
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ACM in the Newsroom

ACM is an integral part of the newsroom and integrates easily within existing Avid 
environments that include products such as Avid iNEWS, Avid NewsCutter, and Avid Media 
Composer. 

This diagram illustrates the various applications that must be installed and configured for 
ACM to function properly. There are two separate environments: the ACM environment and 
the Newsroom environment. They are usually separated by a firewall, which secures the 
Newsroom environment from unauthorized access. As shown, a File Transfer Protocol 
(FTP) is used to transfer data from the newsroom environment to the ACM environment.

ACM Environment

Newsroom Environment

Avid iNEWS workstation

Avid NewsCutter 
workstation

ACM RECORDER

PCTV

MSSQL

ACM Satellites

Web Users

Streaming Server

ENCODER

JBOSS

NEWSPOLLER

1

2
4

3

Avid Media Composer
workstation

ACM workstation

FTP

Use ACM
 to schedule recordingNRCS



ACM Workflows

15

The diagram also illustrates a streaming server and a group of satellites. Broadcasting 
companies usually have a third-party streaming server that is used for streaming video and 
media directly to the web. A satellite web application runs on a web server that ultimately 
provides web pages for the web user. It keeps track of which web pages have been created 
and viewed. It interfaces between the story or asset on ACM and the web. 

The ACM environment consists of the workstation running the ACM application as well as 
the required database and server. 

The Newsroom environment consists of the following:

• Avid products (Avid iNEWS, Avid NewsCutter, and Avid Media Composer).

If there are workstations that are storing and sharing media, then an Avid media storage 
product such as Avid Unity ISIS or Avid Unity MediaNetwork would also be installed in 
this environment.

• One of the recommended encoders (Sorensen, Anystream, or Telestream).

• ACM NewsPoller: This software receives video files from the Avid products and the 
ACM recorder in what is known as a Watch folder before sending them to the encoder. It 
also receives the encoded video file before it is sent to ACM via FTP.

• ACM Recorder and the PCTV HD Pro Stick: These allow the workstation they are 
installed on to record the television broadcast while it is being aired.

ACM Workflows

There are four distinct workflows that can be employed when using ACM. The workflow 
used depends on the hardware and software applications running in your newsroom, If you 
are using Avid NewsCutter together with Avid iNEWS, then follow the workflow that charts 
how the story is moved from the Avid editing system to ACM. If you are a journalist writing 
the story from scratch and associating videos and images to a particular story directly in 
ACM, then follow the workflow that demonstrates how to create the story in ACM.

It is assumed that all required software and hardware are installed and configured.

Here are the workflows:

• From Avid iNEWS to ACM

• From Avid NewsCutter to ACM

• From Avid Media Composer to ACM

• From the ACM Recorder to ACM

• Creating a Story on ACM
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Once the stories are sent to ACM, they can be edited by the Webmaster, Editor, or Journalist. 
Modifications may include applying the broadcaster’s template for the web, categorizing the 
story to make it easier for the web user to find, and adding relevant links.

From Avid iNEWS to ACM

Avid iNEWS is a newsroom staple. It allows the journalist to create and modify stories in the 
newsroom or from any location.

1. The text story or script created in Avid iNEWS is pushed to ACM using Txnet. ACM 
can also be set up by the system administrator to pull the stories at a scheduled time 
using a webservice.

2. The story now appears in ACM. Run a search to locate and load the story for further 
modifications. 

Note that the story loaded from Avid iNEWS maintains its formatting. It may require 
further editing within ACM to make it ready for the web. For example, changing all the 
capital letters, from a teleprompter, to sentence case. 

For further reading, see the Avid iNEWS documentation available on the Avid Knowledge 
Base at www.avid.com/onlinesupport.

Avid iNEWS workstation

FTP 

ACM workstation

1
2

Text and scripts sent to ACM 

http://www.avid.com/onlinesupport
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From Avid NewsCutter to ACM

Avid NewsCutter is a non-linear editing system used in the newsroom to combine text 
content from Avid iNEWS with related footage. The Post-to-Web feature pushes the story 
together with the edited video, to ACM. 

1. Text and scripts are imported from Avid iNEWS to Avid NewsCutter via NRCS. 

2. A video sequence that will correspond to the text is edited. At this stage, special effects 
such as dissolves between clips or the broadcaster’s graphic logo can be applied on the 
timeline.

Using the Post-to-Web feature, the text and the video sequence are pushed to the Watch 
folder on the workstation running ACM NewsPoller.

3. After ACM NewsPoller receives the video file, it is sent to the encoder for compression. 

4. The encoder compresses the video then sends it back to the Watch folder for ACM 
NewsPoller to pick up. 

5. ACM NewsPoller sends the encoded video and corresponding text to ACM via FTP. The 
video now appears as an asset and the story appears on the Story tab. Run a search to 
locate and load the story for further modifications. 

Note that the story loaded from Avid iNEWS maintains its formatting. It may require 
further editing within ACM to make it ready for the web. For example, changing all the 
capital letters, from a teleprompter, to sentence case. 

For more information, see the Avid NewsCutter documentation on the Avid Knowledge 
Base at www.avid.com/onlinesupport.

Avid iNEWS workstation Avid NewsCutter 
workstation

ACM workstation

NEWSPOLLER

ENCODER

1

2

3

4

5

NRCS

FTP

Post to Web

http://www.avid.com/onlinesupport
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From Avid Media Composer to ACM

Avid Media Composer is a non-linear editing system that can be used in the newsroom to 
edit video footage and audio.

1. A video sequence is edited on the Avid Media Composer timeline. Special effects such 
as dissolves between clips or the newsroom’s graphic logo can be applied on the 
timeline.

Export the video to the Watch folder on the workstation running ACM NewsPoller.

2. After ACM NewsPoller receives the video file, it is sent to the encoder for compression. 

3. The encoder compresses the video then sends it back to the Watch folder for ACM 
NewsPoller to pick up. 

4. ACM NewsPoller sends the encoded video to ACM via FTP, which appears as an asset 
in ACM. It can be associated to any story by the ACM Editor.

For more information, see the Avid Media Composer documentation on the Avid 
Knowledge Base.

Avid Media Composer 
workstation

ACM workstation 

NEWSPOLLER

ENCODER
1

2

3

4 FTP

Export
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From the ACM Recorder to ACM

Using the ACM recorder is independent of how the stories are being pushed to ACM.

For this workflow, the following assumptions are made:

• The ACM recorder has been installed and properly configured. 

• The PCTV HD Pro Stick has been inserted in the same workstation running the ACM 
recorder.

• The Watch folders on ACM NewsPoller and the Encoder are properly set up.

1. Use ACM to schedule the ACM recorder to record television broadcast as it is being 
broadcast.

2. The video is recorded on the workstation running the ACM recorder software and the 
PCTV HD Pro Stick and then sent to the Watch folder on the workstation running ACM 
NewsPoller.

3. After ACM NewsPoller receives the video file, it is sent to the encoder for compression. 

4. The encoder compresses the video then sends it back to the Watch folder for ACM 
NewsPoller to pick up. 

5. ACM NewsPoller sends the encoded video to ACM via FTP, where it appears as an 
asset. 

Creating a Story on ACM

Journalists and editors can also write stories directly in ACM. Since ACM is a web-based 
application, journalists in the field can log in remotely and create stories and upload assets 
such as video and images. 

For more information, see “Developing Stories” on page 83.

ACM workstation
NEWSPOLLER

ENCODER

Workstation running 
ACM Recorder and PCTV HD Pro Stick

1 2

3

4

5FTP
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Who are Active ContentManager Users?

There are three levels of Active ContentManager users:

• Webmaster: The Webmaster is responsible for all web communication and therefore has 
the highest level of access. Before you can start using ACM, the webmaster must set up 
the users and projects—see “User and Project Management” on page 33.

A newsroom may have a system administrator who is responsible for setting up the 
infrastructure. The webmaster and the system administrator may liaise to ensure that 
both environments are properly established and functioning and that ACM users are able 
to access the applications.

• Editor: Responsible for editing the story and typically works with Avid NewsCutter and 
Active ContentManager. The Editor has access to all ACM functionality with the 
exception of web template creation and management, a task reserved for the Webmaster. 
Note that the Editor can still apply templates to the news stories. The Editor is also 
responsible for approving stories for web publication.

• Journalist: Responsible for script creation in Avid iNEWS and ACM. The Journalist 
also uses ACM to access stories sent by Avid iNEWS for further modification.



2 Getting Started with ACM

This chapter describes how to get started with Active ContentManager. It describes how to 
log on as well as quickstarts for the different types of ACM users (Journalists, Editors, and 
Webmasters). 

You will find the following information:

• Logging In and Out

• Quickstarts for the Webmaster

• Quickstarts for the Editor

• Quickstarts for the Journalist
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Logging In and Out

As Active ContentManager is a web-based application, your browser must be either:

• Microsoft Internet Explorer version 6.0 or later

• Mozilla Firefox version 2.0 or later.

Before you can start using Active ContentManager, you must log on using your name and 
password. You must also know the project you are working on. If you do not have a user 
name or password, request one from the Webmaster. 

If the user name or password is not recognized by the system, the screen will refresh and 
display the message: Unable to authorize the user for access. This may occur if the user 
account does not exist, or if the user name or password was typed incorrectly. Note that 
passwords are case-sensitive.

Closing the browser window will log you out. If there is no activity on your system, you will 
be automatically logged out (default, thirty minutes). You can change the time limit.

To log in:

1. Launch your preferred web browser.

2. Navigate to your Active ContentManager Website’s login page at the appropriate URL 
given to you, for example, http://myserverip/broadcast.

3. Select the project.

4. Enter your username and password.

5. Click the Login button.

ACM is launched and the Story page is loaded by default.

To log out 

t Click the Log Out tab at the top right corner of the browser window.
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Quickstarts for the Webmaster

The webmaster is responsible for system administration as well as the creation and 
management of projects, user accounts, and templates.

Before Editors or Journalists can start using Active ContentManager, there are a number of 
tasks that the Webmaster has to accomplish. Follow the steps below in the order listed:

 Step Refer to:

 Log in “Logging In and Out” on page 22

 Configure the Watch folder for 
content ingest.

“Configuring the Watch Folder” on page 26

 Create a new project “Creating a Project” on page 34

 Create users “Creating a New User” on page 37

 Create categories “Creating a Category” on page 48

 Assign file domains to import 
images, videos, and any other assets.

“Assigning File Domains” on page 57

 Create authors “Creating a List of Authors” on page 88

In any order:

Note: If you are creating a story, it is a good idea to create credits, sources, and assets first.

 Create sources. “Creating a Source” on page 42

 Create credits. “Building a List of Credits” on page 43

 Create assets. “Creating an Asset” on page 58
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Quickstarts for the Editor

The editor is responsible for creating stories, importing assets such as images and videos, 
approving stories, and story ranking

Quickstarts for the Journalist

The journalist has similar tasks to the editor with the exception of creating categories. It is a 
good idea to create credits, sources, and assets first before writing the story.

 Step Refer to:

 Log in “Logging In and Out” on page 22

 Create categories. “Creating a Category” on page 48

In any order:

Note: If you are creating a story, it is a good idea to create credits, sources, and assets first.

 Create sources. “Creating a Source” on page 42

 Create credits. “Building a List of Credits” on page 43

 Create assets. “Creating an Asset” on page 58

 Create stories. “Developing Stories” on page 83

 Step Refer to:

 Log in “Logging In and Out” on page 22

 Create sources. “Creating a Source” on page 42

 Create credits. “Building a List of Credits” on page 43

 Create assets. “Creating an Asset” on page 58

 Create stories. “Developing Stories” on page 83



3 Managing Ingest Tasks and Recorders

When setting up the newsroom environment, the Webmaster or the newsroom system 
administrator must make sure that ACM NewsPoller and the Encoder are installed and 
properly configured. Watch folders must also be created and configured on the workstation 
running ACM NewsPoller and the Encoder to successfully receive stories and media such as 
videos and images. These are eventually sent to the ACM workstation via FTP. 

If the newsroom is using ACM recorders to capture on-air videos in its workflow, the 
webmaster must use ACM to add them so that recorded videos are successfully encoded 
before they are sent to ACM. 

You will find the following information:

• Configuring the Watch Folder

• Configuring Avid iNEWS Ingest

• Creating an Ingest Task

• Modifying an Ingest Task

• Using Recorders
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Configuring the Watch Folder

The Webmaster must configure the Watch folder on ACM so that it can receive stories and 
media such as video and images from ACM NewsPoller at specified intervals. Only one 
Watch folder can be configured per project—see “User and Project Management” on 
page 33.

This procedure makes the following assumptions:

• ACM NewsPoller is installed and properly configured.

• The Encoder is installed—see “ACM in the Newsroom” on page 14 for a list of qualified 
encoders.

To configure the Watch folder:

1. Click the Ingest tab.

2. Click Configure Watch Folder.

3. Select the user from the drop-down list.

4. Enter the Polling location, which is the path to the Watch folder.

5. Enter the polling interval in minutes and seconds. This will define the times when the 
newly received data will be polled. For example, if you enter 0 minutes 55 seconds, then 
the data will polled every 55 seconds.

6. Select an abstract delimiter if you want the story abstracts to be automatically extracted 
from the story’s body at the time of ingestion.

• Use first carriage return: Uses the text before the first carriage return of the 
story’s body as the abstract of the story.

• Use first paragraph: Uses the first paragraph of the story’s body as the 
abstract. This is indicated by the first HTML paragraph tag <p>.
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7. Select the Enabled check box to enable the polling.

8. Click Save.

Deleting a Watch Folder

You can delete the Watch folder and its associated information at any time. 

To delete the current polling configuration:

1. Select the Ingest tab.

2. Click the Configure Watch Folder link.

3. Click Delete.

A delete confirmation message appears.

4. Click OK.

Creating an Ingest Task
Creating an ingest task is two-fold:

• The webmaster may create an ingest task so that text stories from Avid iNEWS are 
pulled from ACM. Make sure that the host name and port of the workstation running 
Avid iNEWS Web Service has been defined—see “Configuring Avid iNEWS Ingest” on 
page 29.

• The webmaster may also set a schedule for recording video. Once the recorder is 
configured, you will need to set up a schedule for recording, which is done by creating 
an ingest task.

To create a new ingest task:

1. Click the Ingest tab.

2. Click Create.
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3. Enter a name for the new ingest task. 

4. Select the user.

5. Enter the rundown path which will determine which rundown in the Avid iNEWS 
system to pull stories from and will define which recordings become associated with 
which stories in the ACM system. 

For example, 10PMSHOW.10PM-RUNDOWN

6. Enter keywords, if applicable.

These keywords will be associated with both the recordings and the stories created as a 
result of this task.

7. Select the frequency at which the ingestion will take place.

8. Enter the date you want this ingest task to start. 

To access the calendar, hover over the date and click. 

9. Enter the start time for the task.

Enter the time in hours and minutes.

The time entered must be at least five minutes in the future.

10. If your ingestion frequency is weekly, select the days you want the ingest to take place. 

11. On the right-hand panel, select one of the following. The selection determines the 
available options. For example, the Record video and pull stories selection will display 
options that you need to set when the task is for both video and story ingestion. 



Configuring Avid iNEWS Ingest

29

12. Click Create.

Configuring Avid iNEWS Ingest
As seen in the From Avid iNEWS to ACM and From Avid NewsCutter to ACM workflows, 
Avid iNEWS plays an important role in the newsroom. 

In addition, ACM can be configured to pull stories directly from an Avid iNEWS system at a 
predetermined time—see “Creating an Ingest Task” on page 27. You must also specify the 
location of the Avid iNEWS Web Service that is used to access to the workstation running 
Avid iNEWS from which the stories will be retrieved.

To configure the Avid iNEWS Ingest

1. Click the Ingest tab.

2. Click Configure iNEWS Ingest.

3. Enter the Host Name of the Avid iNEWS workstation.

4. Enter the Port and click Save.

Option Steps

Only record video 1. Select the recorder that will be used to record on-air broadcast 
videos.

2. Enter the recording duration.

3. Enter a description for the video asset. 

Only pull stories 1. Select the recorder that will be used to record on-air broadcast 
videos.

2. Select a delimiter to define how the story will be displayed.

• Use first carriage return: Use first carriage return: Uses the text 
before the first carriage return of the story’s body as the abstract 
of the story.

• Use first paragraph: Uses the first paragraph of the story’s body 
as the abstract. This is indicated by the first HTML paragraph tag 
<p>.

3. Add or create categories—see “Working with Categories” on 
page 47.

Record video and pull stories All options for ingesting video and stories are available.
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Modifying an Ingest Task

You can modify any of the variables for an existing ingest task. When you no longer need an 
ingest task, delete it.

To change the name of an ingest task:

1. Select the Ingest tab and click Modify.

2. Select the ingest task you want to modify.

3. Make the changes and click Save.

To delete an ingest task:

1. Select the Ingest tab and click Delete.

2. Select the task from the drop-down list.

3. Click Delete.
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Using Recorders

In order to record and ingest on-air video, you will first need to configure at least one 
recorder to capture on-air videos. Shown here is how the Active ContentManager recorder 
fits in the newsroom environment.

Adding Recorders

Once the recorder has been installed and connected, you will need to configure it so that it 
can capture on-air video. After adding a recorder, you can schedule a recording—see 
“Creating an Ingest Task” on page 27.

When you no longer need a recorder, you can delete it from the list.

To add a recorder:

1. Click the Ingest tab.

2. Click Manage Recorders.

3. Click Add New Recorder.

Newsroom Environment

ACM RECORDER

PCTV

ENCODER

NEWSPOLLER

Machine running ACM

FTP

Use ACM
 to schedule recording

ACM Environment
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4. Enter a name for the recorder.

5. Enter the IP address or host-name of the recorder machine.

6. Enter the FTP subdirectory path.

7. Enter the FTP port.

8. Enter a username and password that will be used to login to the FTP server on the 
recorder.

9. Enter a Padding value.

10. Click Add.

To delete a recorder:

1. In the Manage Recorders window, select the recorder you want to delete from the 
drop-down list.

2. Click Delete.



4 User and Project Management

The Webmaster is responsible for creating projects and users such as Editors and Journalists. 

A project contains all information required for a news website, such as stories, user 
accounts, links, sources, and templates. The project is eventually the website available to 
web users.

You will find the following information:

• Working with Projects

• Setting up Users and Accounts
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Working with Projects

Each website must have its own project. Therefore, if you have more than one website, you 
must create a project for each.

Creating a Project

The project name must be unique. You can create user accounts for each project and each 
user will have specific permissions for that project.

To create a project:

After a project is created, its name will appear in the Project drop-down list on the Active 
ContentManager login page. The only user account that will exist in the newly created 
project is actually a copy of the Webmaster’s account which created the project. The system 
does not log you into the new project upon creation, therefore you must exit the current 
project and then log in to the newly created one.

2

1

3

Click the Project tab 
and then click Create.

Click Create.

Enter the name of the project

4

Enter the Base URL.This is 
the prefix of the website 
address that will be used.
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Changing the Project Name

Renaming a project does not alter any information within the project; the information 
remains associated with the project but under a new name. The new project name will appear 
in the Project drop-down list on the Active ContentManager login page.

To change the name of a project:

1. Select the Project tab and click the Modify link.

2. Enter a new name and click Save.

Previewing a Project

You can preview a project if a template is associated with it—see “Using Templates” on 
page 63. 

To preview a project:

1. Select the Project tab and click Preview.

2. If you want to preview the project using a template, click Import template for project. 

3. Do one of the following:

- Click the Preview button to preview the project.

- Click the URL button to preview the project in the format defined by the imported 
template.

A window opens to display the project.

Deleting a Project

When you no longer need a project, you have to export it first and then delete it. This is 
useful, if you ever need to restore the project.

To delete a project:

1. Select the Projects tab and click Delete.

Make sure that the project name you want to delete is displayed.

Click this button to copy the project’s 
ID to a clipboard for later use.
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2. Click the Delete button.

3. In the confirmation dialog box, click OK.

Setting up Users and Accounts

Once a project has been created, users have to be assigned. The Webmaster is responsible for 
creating users and assigning roles.

User Accounts

There are three types of user accounts that can be created. Each type of account is predefined 
with rights and responsibilities that determine the level of access privileges. Here is a 
summary:

User Responsibilities Available Tasks

Webmaster All responsibilities of an Editor and Journalist. Also 
responsible for project, user account, and template 
creation and management.

All

Editor Creating stories, importing assets such as images and 
videos, approving stories, and story ranking

• Story

• Weather

• Asset

• Category

• Source

• Credit

• Ingest

Journalist Creating stories and importing assets such as images 
and video.

• Story

• Weather

• Asset

• Source

• Credit
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Creating a New User

Only the Webmaster is able to create and manage new users.

To create a user:

1. Log in as a Webmaster. 

2. Select the User tab. 

3. Enter a unique user name and password. 

The password is case sensitive. 

4. Re-enter the password to confirm that it is entered correctly. 

5. Enter the user’s first and last names.

6. Optional: Enter the user’s email address.

7. Optional: Enter the user’s position title.

8. Assign the user a role. 

Keep in mind that the user will have access to functions and tabs depending on the role 
assigned. For example, a Journalist will not have access to the Category tab.

9. Click Create.
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Modifying an Existing User

As a Webmaster, you have the ability to change the information of an existing user. For 
example, you may want to change the user’s role from a Journalist to an Editor. 

The changes take effect immediately, but if a user is logged in when their account is being 
modified, these changes will only be apparent at the next log in. For example, if a Journalist 
is promoted to an Editor, then the Category tab will not appear until the Journalist logs out 
and back in. However, if the user’s role is modified to a setting with decreased privileges, the 
user will be forced to log in again whenever he attempts an action he no longer has a right to 
initiate.

To modify an existing user account:

1. Select the User tab and click Modify. 

2. Select the user you want to modify from the drop-down list.

3. Modify the information as necessary.

4. Click Save.
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Deleting a User

A user’s account can be deleted when it is no longer required in the system. When deleting a 
user, take note of the following:

• If an attempt is made to delete the last Webmaster in a project, an error occurs. 

• When a user’s account is deleted while that user is logged in, the deletion will not take 
effect until after the user logs out. They will be unable to log in again. 

• If a user, who is also an author of a story, is deleted, that user is no longer able to access 
the system, but remains associated with the story as its author.

To delete a user account:

1. Select the User tab and click Delete.

2. Select the user from the drop-down list.

3. Click Delete.

A delete confirmation message appears.

4. Click OK.
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5 Managing Sources and Credits

Any news story, whether it is in a newspaper, a magazine, or on the web, will have a source 
or sources associated to it. A source refers to a news gathering agency that distributes 
information to media all over the world around the clock. Examples of internationally 
recognized news agencies or sources are Reuters, Associated Press (AP), Agence 
France-Presse.

Credits are also part of a news story and they identifies the role of the author or editor.

You will find the following information:

• Creating a Source

• Building a List of Credits
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Creating a Source

Before you can associate a news story with a source, you will have to create it. Once created, 
the system stores the list of sources in a searchable database.

Any ACM user can create and manage sources.

To create a source:

1. Select the Source tab.

2. Click Create.

3. Type the name of the source.

4. Click the Create button.

Modifying an Existing Source

If you are a Webmaster or a Journalist, you can change the name of an existing source if, for 
example, you have made a spelling error or if the name of the news agency changes. If a 
Journalist attempts to modify the source, the system will log out the user and reload the log 
in page with a You cannot modify a source that is referenced by an approved story. 
message.

If a source is already associated with a story, you will see the message: This source is 
already referenced by a story However, if a source is not associated with a story, you will 
see a This source is not reference by any story message.
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To modify a source:

1. Select the Source tab and click Modify.

2. Select a source from the drop-down list.

The source’s name will appear in the Source Name text field.

3. Modify the name and click Save.

Deleting a Source

A source that is no longer in use can be deleted. If it is associated with an approved story, 
only the Webmaster or Editor can delete it.

To delete a source:

1. Select the Source tab and click Delete.

2. Select a Source from the drop-down list.

The source’s name will appear in the Source Name text field.

3. Click the Delete button.

If the source you are attempting to delete is referenced by a story, this information is 
shown below the Source Name text box and again after clicking the Delete button in the 
delete confirmation dialog box.

4. Click OK to complete the deletion.

Building a List of Credits

Credits identify the author’s role in the production of the story or forecast. They may 
include: Written by, Reported by, Edited by, and Forecasted by. 

Webmasters, Editors, and Journalists can create, modify, and delete credit titles. Credits go 
hand-in-hand with creating and adding authors—see “Removing Associations” on page 94 
and “Adding Authors to a Story” on page 89.
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Creating Credit Text

A Webmaster, Editor, or Journalist can create credits that are used within stories or forecasts 
by associating them with authors. This association can only occur once per story.

To create a Credit:

1. Select the Credit tab.

By default the Create page is loaded.

2. Enter the Credit Text.

3. Click the Create button.

The Credit is added to the list of credits.

4. Repeat to add more credits.

Modifying Credit Text

You can edit the name of a credit at any time. If a credit has already been referenced by 
stories or forecasts, the new credit name will automatically replace the previous credit name. 

To modify a Credit:

1. Select the Credit tab and click Modify.

2. Select a credit from the drop-down list. 

3. Edit the credit that is displayed in the Credit Text box.

4. Click Save.
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Deleting Credit Text

If a project no longer requires a credit, you can delete it. Credits already referenced in stories 
or forecasts can still be deleted. The credit will be removed from each story or forecast.

To modify a Credit:

1. Select the Credit tab and click Delete.

2. Select the credit you want to delete from the drop-down list. 

It is displayed in the Credit Text box.

3. Click the Delete button.

4. Click OK to confirm the deletion.
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6 Working with Categories

Categories are descriptive groups with which stories can be associated. One of the common 
categories used in the industry is “Top Stories”, which classifies the most news-worthy 
stories of a given time period. Another familiar one is “Sports”, which groups stories about 
sports-related events. Others include Business, Politics, and Weather.

Webmasters and Editors have permissions to create and manage categories. Journalists can 
then assign their stories to a category.

You will find the following information:

• Creating a Category

• Previewing Categories

• Ranking Stories
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Creating a Category

When faced with an influx of stories, it is a good idea to create categories under which they 
can be organized. For example, you may want to group all pop culture-related stories under 
an Entertainment category. This practice also makes it easier for web users to locate stories 
faster. You can create as many categories as you need as long as their names are unique. 
Categories can also be set up to automatically rank stories—see “Ranking Stories” on 
page 51. 

n You can also create a category when creating a new story—see “Developing Stories” on 
page 83. This is useful when a new story does not fit in any of the existing categories.

To create a category:

1. Select the Category tab.

2. Click Create.

3. Enter a unique name for the new category.

4. Enter a keyword for the category and press Enter. 

You can enter as many keywords as you want. These help organize the stories and 
facilities searches.

5. If you want to delete a keyword from the list, select it and click Remove.

6. Optional: Select AutoRank. If a category is marked as autoranked, any approved story 
added to the category will automatically be added to the category's ranked list in the first 
position. All other stories positions will adjust accordingly

If a new story is added to the project and approved, it is automatically ranked.

7. Click Create.



Previewing Categories

49

Modifying a Category

You can change the category name, add and delete keywords, or the AutoRank status. After 
a category is modified, its new name is proliferated throughout the project so that all screens 
that reference that category will have the new information.

To modify a category:

1. Select the Category tab and click Modify.

2. Select the category from the drop-down list.

3. Make the changes and click Save.

Previewing Categories

For each category, the Preview feature is available, allowing Editors and Webmasters to 
quickly see how various categories and templates affect the site.

To preview a category:

1. Click the Category tab. 

The Rank Stories for this Category page appears by default.

2. Select a category from the drop-down list. 

The page will reload, displaying stories associated with that category and providing the 
Preview section at the bottom right corner of the page.
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3. At the bottom-right of window, select a template from the drop-down list. 

A new browser window opens, allowing you to preview the selected category as defined 
by the chosen template.

4. To view the category through a different template, return to the original browser window 
and select another template.

Deleting a Category

If you no longer require a category, you can delete it from the project. Be careful when 
deleting, because deleting a category will also delete the associations of any stories to that 
category.

To delete a category:

1. Making sure you are in the Category tab, click Delete.

2. Select the category you want to delete from the drop-down list.

The selected category will appear in the Category Name field.

3. Click Delete.

A delete confirmation message appears.

4. Click OK.
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Ranking Stories

Although this is typically a task for the Editor, the Webmaster has access to this function.

As stories are created and approved, they are explicitly ranked by default. As you create 
categories, you can also use the AutoRank option to automatically rank recently saved and 
approved stories for that category as the top story. In this case, all other stories will be moved 
down one position. When an unranked story is ranked it defaults to the top position on both 
the search results and rank stories pages.

You can also rank or order approved stories within a category by importance. This process 
enables you to better manage the order in which a list of stories appears on the website. Only 
stories that are regarded as significant need to be ranked. If a ranked story’s approval is 
removed, the story is immediately removed from the ranking list. 

A category can have an unlimited number of unranked and approved stories, but it can only 
have up to 100 ranked stories.

Removing a story from a category’s rank list does not delete the story from the system or 
remove the story from the site. It may still appear on the site, such as through a link added to 
another story.

There are three ways to rank stories:

• Ranking Stories by Category Search Results

• Ranking Stories within a Category

• Scheduling a Story for Ranking

Ranking Stories by Category Search Results

You can run a search by category and rank approved stories in the search results list.

To search stories using the category:

1. Select the Story tab.

The Search page is loaded by default.

2. Select the category you want to search from the Category drop-down list.

The stories for that category are loaded. You can see the position of each story. For 
example, the “Oil Prices” story is ranked first, the “Afghan Battle” story is ranked 
second, while the other stories are not yet ranked but can be ranked by clicking the up 
arrows.
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A story that has not been approved cannot be ranked.

3. Click the arrows to rank the stories. 

The up arrow for the #1 ranked story is disabled because the story is already assigned 
the highest rank available. When you rank a story, the next unassigned number will 
display as the rank position.

Ranking Stories within a Category

Stories can be ranked or unranked within a category.

To rank a story:

1. Select the Category tab.

2. Select the category from the drop-down list.

3. Optional: Filter the selection to show stories for a specific time period.

4. In the Unranked and Approved Stories list, select the story or stories that you want to 
rank.

5. Click Rank Story >>.

The story or stories will move to the Ranked Stories list.
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6. In the Ranked Stories list, you can rank the order by selecting and clicking the up or 
down arrows.

7. Click Save.

8. If you want to edit the story, click the Edit button and see “Developing Stories” on 
page 83

To unrank a story:

1. Select the Category tab.

2. Select the category from the drop-down list.

3. Optional: Filter the selection to show stories for a specific time period.

4. Select the story or stories in the Ranked Stories list.

5. Click << Unrank Story. 

The story or stories will be moved to the Unranked and Approved Stories list.

6. Click Save.

7. If you want to edit the story, click the Edit button and see “Developing Stories” on 
page 83.

Scheduling a Story for Ranking

Editors can schedule a story to have its ranking in a Category changed. Stories can be ranked 
for a specific time, date, rank, or category. Multiple task rankings may be scheduled for a 
single story. 

For instance a story may be ranked first in a specified category for an hour on a certain date, 
then ranked second for another hour or two, then third for three hours, and finally removed 
from the category’s rank list completely. To do this, would require four tasks. Another task 
could be set up to rank the same story to a completely different category on a separate 
schedule.

To schedule a story for ranking within a category:

1. Click the Story tab.

2. Search for a story and click it to load it for editing.

3. Go to the Schedule tab. 

If this is the first time that a task is being scheduled for the story, you will see a “There 
are no tasks scheduled for the story” message.

4. Click Add Task.

The Schedule New Task window appears, with the name of the story at the top, as 
shown in the following figure.
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5. Select the category.

6. Set the type of task:

• Set RANKED as associates the story to the selected category at the rank 
provided. Enter the rank number.

• Set as UNRANKED associates the story to the selected category without any 
rank assigned. If the story is already ranked within the selected category, choosing 
this option will unrank the story within the category. 

• Remove from category removes the stories association with the selected 
category.

7. Set the date and time for the task.

8. Click Add.

The task is added and displayed on the Schedule page.

9. To continue adding tasks, click Add Task.

10. To delete a scheduled task, click the Trash button.



7 Using and Managing Assets

Assets are files that can be added to enhance a story on the website. These may include 
audio, video, and image files. They can be stored and managed using the Avid Active 
ContentManager. 

You will find the following information:

• Media Formats Supported

• Assigning File Domains

• Working with Assets
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Media Formats Supported

Active ContentManager supports a wide range of assets:

• Image: jpg, jpeg, jpe, gif, png

• Quicktime: mov, QT

• RealMedia: ram, rm, rpm

• Windows Media: asf, wmv, wma

• Shockwave Media: swf, flv

• MPG: m4v, mpg

Any other file extension, such as txt, doc, mp3 is classified as Other.

There are two icons used to differentiate between video recordings and images:

Users may create, search for, modify, or delete assets from the system. They may also 
associate one or more assets with any story or stories in a project—see “Adding Media to the 
Story” on page 91.

Video recordings

Images
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Assigning File Domains

A File Domain is a logical storage location for all assets for the system, for example, 
Quicktime videos can be saved to a Quicktime file domain. When working with projects, a 
file domain must be assigned for the different types of media the project is using, otherwise 
you will not be able to import the media.

The file domains must first be created and defined by the Webmaster—see the Avid Active 
ContentManger SDK User Manual.

To assign a file domain:

1. Select the Asset tab and click Assign File Domains.

2. Select a file domain for each asset type from the corresponding drop-down lists.

3. Click Save.
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Working with Assets

A Webmaster, Editor, or Journalist can create, modify and delete assets associated to a story. 
Any asset can be associated with a story. 

Creating an Asset

Creating an asset involves importing a file into the Active ContentManager system and 
associating a name, description, and keywords with that file. The file will automatically be 
placed in the appropriate File Domain created for its asset type—see “Assigning File 
Domains” on page 57.

Once the asset is created it is ready to be referenced by stories, weather forecasts and 
templates. There are four categories: Image, Video, Other (such as text files), and on-air 
recordings—see “The Associations Tab” on page 86 and “Adding and Managing 
Associations” on page 88.

To create an asset:

1. Select the Asset tab and click Create.

2. Enter a name for the asset. 

3. Select one of the following:

- General Use: These assets are used for all stories except weather stories.

- Weather Image: These assets, which must be image, are used for weather forecasts 
and stories. After uploading these images, you can easily run a search by clicking 
Weather Images.

4. Optional: Enter a description.

5. Optional: Enter a keyword and press Enter to add it.

If you want to delete a keyword, select it and click Remove.

6. If you are using a file, select the file and click the Browse button to locate it.

7. If you are using a URL, select URL, enter the link and choose the type of asset from the 
drop-down list.

8. If you want to associate a thumbnail with this asset, click the Browse button and locate 
it. This is especially useful when you have a huge library of video footage. You can use 
thumbnails to differentiate between the videos.
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9. Click Create.

Searching for Assets

You can search for assets by setting various search criteria.

To search for an asset:

1. Click the Asset tab.

2. Do one of the following:

- Click Search. 

The Search for News Assets page appears.

- Click Search By ID to search by the asset ID.
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3. Fill in the Search field(s) accordingly. 

4. Click the Search button.

The search results are displayed.

5. Click a thumbnail to preview the asset.

The filmstrip thumbnail image indicates a video asset, while the OTHER indicates an 
asset other than image or video, such as a Shockwave file.

6. If you are logged in as a Webmaster, the Copy icon appears under each search result 
thumbnail image. The icon is not displayed for either Editors or Journalists.

Options Description

By Asset Name Users can search for a word or phrase that may appear in the asset’s 
name.

By Description Users can search for a word or phrase that may appear in the asset’s 
description.

By Keyword Users can search for a word or words that may appear in the asset’s list of 
keywords

By Date Users can search for assets last modified within predefined date ranges: 
the last 24 hours, 7 days, 14 days, 30 days, or 60 days.

By File Type Users can search for assets by file type. The options are: All, Image, 
Video, and Other.

By ID Users can search for assets by their designated IDs.
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Copying an Asset’s GUID

Copying the GUID, also known as a Globally Unique IDentifier, can be used by the 
Webmaster when creating templates to retrieve any object in the system. For example, if the 
broadcaster’s logo has been imported to ACM, the Webmaster can use the 
SearchHelper.getByID statement to create a reference to it on every template that needs to 
display that logo—see “ACM Template Syntax” on page 69.

To copy an asset’s GUID:

• Click the Copy icon located under that asset’s thumbnail image. 

The GUID is stored on the computer's clipboard and can then be pasted into any text 
field, such as a template in a text-based applications such as Notepad.

Modifying an Asset

You can modify the asset to give it a new name or description, or to add keywords to its list. 
You cannot modify the actual image or video file but you can replace it. When the file is 
replaced, all stories or templates referencing it will reflect this change.

When an asset is associated with a story, This asset is referenced by a story will be 
displayed. Only Editors and Webmasters may modify assets associated with approved 
stories. A Journalist attempting to save modifications to an asset associated with an approved 
story will receive the warning The asset with ID=<n> is currently being used in an 
approved story.

n Once an asset is created, you cannot change its asset type. You cannot replace an image with 
a video, or a specific type of video with a different type of video.

To modify an asset:

1. Search for the asset you want to modify.

2. When the search results appear, click Modify.

3. Modify the fields, as needed, or browse to re-import a new file.

4. Click Save.
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To save an image asset to an external folder:

1. Search for the asset you want to save.

2. When the search results appear, click the thumbnail image to open the asset for 
previewing in another window.

3. Right-click on the image in the preview window.

4. Click Save Picture As.

5. Specify the location and filename for the image.

6. Click Save.

Deleting an Asset

Only Editors and Webmasters can delete assets. When an asset is deleted, the system also 
deletes the underlying physical file in the File Domain.

To delete an asset:

1. Search for the asset you want to delete.

2. When the search results appear, click Delete.

3. Click OK to delete the file.



8 Using Templates

Template management is one of the most powerful features of Active ContentManager. 
Templates can be customized to achieve the desired look and feel for your website. The task 
of managing and modifying templates is reserved for the Webmaster.

The Webmaster can design the website using any web authoring program. These files must 
be saved to a location where they can be loaded or imported into ACM as templates.

You will find the following information:

• Working with Templates

• Working with URLs
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Working with Templates

Templates are used to transform ACM objects, such as stories and images, into textual 
formats for different types of output such as websites, RSS feeds or XML. It can be used to 
define the layout of the pages in your website and how the ACM data is presented within 
them. This is done by embedding Velocity Template Language commands within the 
templates text

A project can use different templates for the same news item. For instance, a breaking sports 
story may be viewed on the Sports page that is employing the SportsStory template and on 
the home page that is using a BreakingNews template.

You can preview templates from the Project, Category, and Story tabs. 

n For each template the user wants feedback for the story they must add the appropriate 
template tag—see “ACM Template Syntax” on page 69.

A Tour of the Manage Templates Interface

The Manage Templates interface is designed to easily upload and view templates. 
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The Template Browser

All imported templates are organized and displayed in the following ways:

• Name: The templates are sorted alphabetically. 

• ObjectType: They are organized by the type of object such as Category, Story, or Asset. 
The ObjectType is defined in the template.

Template View

This is where the template syntax is displayed. To edit the template, copy and paste the 
entire text in text editor such as Notepad or Wordpad.

Importing Templates

After designing your template using a 3rd-party editor, you can import it into ACM. Make 
sure that the files are in an accessible folder.

To import a template:

1. Select the Template tab.

The Manage Template page is automatically loaded.

2. At the bottom of the page, select Create New.

3. Click the Browse button and navigate to the location of the template.

4. Select the template and click Open.

5. Click Save.

The template is loaded in the Template View Window.

6. Repeat the above steps to import more templates into ACM.

Replacing Templates

Templates are fully editable and can be modified after they have been imported. They can 
also be replaced with new templates.

To edit an existing template:

1. Select the Template tab.

2. Click Manage.

3. Select Name or ObjectType to locate the template that you want to replace.



8  Using Templates

66

4. At the bottom of the page, select Replace existing.

5. Click Browse and locate the template you want to use.

6. Click Save.

7. Edit the template and click Save.

Deleting Templates

You can delete templates when they are no longer required for your website.

When you delete a template, all of the web pages will become invalid and will no longer be 
accessible by the web user. Deleting templates, however, has no effect on the stories 
themselves. They can still be viewed through any other template that is appropriate for them.

To delete a template:

1. Select the template in the Template Browser.

2. Click the Delete button.

3. Click OK.
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Working with URLs

When the Webmaster creates a project, you can enter a base URL—see “Creating a Project” 
on page 34. This is a web link or a unique address that is used to preview and later publish 
the homepage of the website. A website can contain a number of pages that are based on 
templates that have been loaded or imported and modified. Usually a long mapping string is 
used to identify the page created from the template. Active ContentManager gives you the 
ability to associate a logical or friendlier name to the page so you can easily recognize it and 
better manage your news website.

Creating Friendly URLs

You can associate a long string with a short and meaningful name to improve usability and 
keep the pages of your website organized. You can create friendly URLs from any page on 
the application that lets you select a template and map a link, such as the Rank Stories page 
of the Category tab.

To create a friendly URL for a story:

1. Click the Story tab and do one of the following:

- In the Search page perform a search to find the story you want to use and click the 
appropriate link.

- In the Create page, enter the content and its associations and click Create & Edit.
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If you are in the Category page, go to the Rank Stories page and select a Category from 
the drop-down list.

2. Select a template from the drop-down list at the bottom of the page.

3. Click URL.

The Create a Friendly URL opens.

4. Enter a name for the page that will replace the long string shown under Mapping.

5. Click Create.

Managing Friendly URLs

You can view and delete friendly URLs on the Manage Friendly URLs page. You can also 
sort the stories using any of the columns.

Delete buttonTemplate column sorted 
in ascending order



9 ACM Template Syntax

Creating templates is at the core of the dynamic web sites which are enabled by ACM. 
A template defines how a story (or other object) will look within your web site.

In order to create a template you must first design how you wish to have your website 
appear. If you already have a web site that you are transforming into a dynamic web site 
using ACM you have already done this.

Once this is done it becomes a matter of determining which portions of a page would be 
static (unchanging) and which portions of the page are dynamic. You need to decide which 
of the dynamic elements map to which attributes of objects stored in the ACM system. Then 
you use the ACM template syntax to define where those attributes values will be substituted 
within your templates at the time the pages are requested by the end users.

You will find the following information:

• Web Site Navigation in ACM

• Object Types in ACM

• Velocity Template Language – The System behind the Templates
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Web Site Navigation in ACM

One of the biggest differences between a traditional web site and a dynamic web site created 
with ACM is the way that you must think about navigation within the web site. Because all 
of the pages are created dynamically, the way that users will navigate from page to page is 
through the relationships that exist between the objects in your system, rather then explicitly 
through absolute links. 

For example, rather then having a main page that will link to specific stories that you have 
deemed the “Top Stories” for your site; you will instead create a page that displays the “Top 
Stories” Category and dynamically creates links to the first few ranked stories in that 
Category based on its ranked stories attribute.

Object Types in ACM

One of the most important concepts in writing template for ACM is understanding the types 
of objects that are available to render and their relationships to one another. The 
categorization of objects is defined within ACM by their Object Type. The object type 
defines which attributes a certain object has.

For example, an object of the NewsStory object type has a headline and a body while an 
object of the NewsCategory object type has a name and list of Ranked stories.

The attributes of an object type have two main components, the name of the attribute and the 
type of information that it contains. The name is used to reference that attribute to retrieve its 
value for a particular object and the type is necessary to know what kind of value it will 
return so that it can be displayed correctly in the template.

Data Types in ACM

Following is a list of the data types used by attributes in ACM:

• Boolean – a true or false value which can be used in conditional statements.

• Number – an integer number.

• Date – a date which can be formatted in a number of different ways.

• String – a list of characters. Could be a single word or an entire document of text.

• Object Reference – a reference to another object in the ACM system. This type of 
attribute is how relationships between objects in ACM are stored.
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In addition to the above data types, an attribute also has a multiplicity. This defines how 
many values of its data type it can store. For simplicities sake, an attribute can be thought of 
to contain one or more then one value. If it contains more then one value it is referred to as 
returning a List of values of the attributes data type. For example the NewsStory object type 
has a headline attribute with data type of string. NewsCategory object type has a keywords 
attribute with data type string that can hold multiple strings (a list of strings).

Short Object Type Names

Short Object Type names are the same as ACM Object Type names with the “News” prefix 
removed. They are used within the template to reference the attributes of objects of different 
types. E.g. $Story.headline would retrieve the headline attribute from a NewStory object.

The ACM Object Model

The following diagram shows all of the object types in ACM, their attributes and their 
relationships to one another.
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Velocity Template Language – The System behind 
the Templates

The Velocity Template Language (VTL) is meant to provide the easiest, simplest, and 
cleanest way to incorporate dynamic content in a web page. Even a web page developer with 
little or no programming experience should soon be capable of using VTL to incorporate 
dynamic content in a web site.

VTL uses statements to embed dynamic content in a web site. There are many different 
types of statements that allow the template creator to add variables, comments, loops and 
conditional statements.

Please see http://velocity.apache.org/engine/devel/user-guide.html for complete 
documentation on the VTL.

The ACM system provides additional VTL statements for easily accessing the information 
stored in the ACM system. These statements are embedded within HTML and the values are 
filled in when the page is requested (rendered).

Types of ACM Statements

ACM VTL statements can be broken up into three broad categories:

1. Statements that specify metadata about the template itself.

2. Statements that provide access attributes of ACM objects.

3. Statements that allow you perform operations with ACM objects.

The description of each of these statements and what they can be used for are as follows.

Items shown in the syntax in blue italics are the variable part of the syntax where you can 
provide your own values.
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Template Metadata Statements

Template Name

The template name is used to identify the template once it has been imported into ACM. The 
name must be unique for all templates in the project.

Syntax: $MetaData.set($MetaData.NAME, 'TEMPLATE_NAME')

Example: $MetaData.set($MetaData.NAME, ‘Main_Story’) 

Template Object Type

Each template is designed to render one object of a particular type. See the preceding Object 
Type section for a complete description of object types. Examples of types in the ACM 
system are:

Syntax: $MetaData.set($MetaData.OBJECTTYPE, 'TEMPLATE_OBJECTTYPE')

Example: $MetaData.set($MetaData.OBJECTTYPE, ‘NewsStory’) 

Specifying an object type for a template provides a way for the system to know which group 
your template belongs to. For example, the object type will define which templates will be 
able to be selected on the preview drop-down for the various screens (i.e. NewsCategory 
template on the Category preview drop-down). The object type is also used in the template 
navigation tree on the template management screen to allow you to browse for templates by 
their object type.

Note, the template’s object type does not restrict which attributes can be displayed through 
the template, but rather simply categorizes the template within the ACM system. Thus, just 
because a template is a NewStory template does not mean that it is incapable of displaying a 
NewsCategory’s name, just that it will be categorized as a NewsStory template within the 
ACM system.

NewsStory NewsCredit

NewsCategory NewsLink

NewsStoryAuthorCredit NewsSource

NewsUser NewsProject
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Attribute Access Statements

All of the statements to access attributes follow a similar syntax. I will not list all of them 
here, but rather will indicate the syntax to follow when accessing any of them. For a 
complete list of attributes available, see the ACM Broadcast Object Model or the Syntax 
Helper AIR Application provided with ACM.

The general syntax to retrieve any attribute of an object is:

Syntax: $ShortObjectTypeName.attributename

Example: $Story.headline

Attributes from referenced objects may be chained together in a single statement using 
“dot-notation”. This allows you to drill down the object hierarchy in a single statement to 
display the value of a referenced object.

For example, if you wished to display the number of hits that had been recorded against a 
story you would have to retrieve the “hits” attribute from the story’s popularity object. To do 
this you could use the following statement:

$Story.popularity.hits

This drills down, from the story, to get its popularity object and in turn, retrieves the 
popularity object’s hits attribute, outputting its value on the template.

List attributes return lists when they are retrieved. In order to retrieve the values contained 
within the list you will need to use VTL statements for processing lists. Usually you will use 
a #foreach statement to loop through all of the values in the list or will use the direct 
access notation for the list to access a particular element. Direct access of lists is done using 
the get statements (remember that VTL lists are zero-based lists). E.g. 
$Story.images.get(0) would retrieve the first image in the story’s images list.

List access and the dot-notation can be combined to do complex access of the object model. 
For example, if you were displaying a story and had a business rule that you needed to 
display the headline of the top-ranked story in the current story’s first category on the page 
you could do something like:

$Story.categories.get(0).rankedStories.get(0).headline



9  ACM Template Syntax

76

Tools - Template Operational Statements

The ACM template syntax provides a number of tools to assist you in creating your 
templates. Each of these tools has a number of functions. The tools are all included in the 
Syntax Helper AIR Application provided with ACM and can be found on the Tools tab.

Hit Count Tool

The HitCountTool is used on NewsStory templates and when present, indicates to the ACM 
system that any story rendered through this template is to cause the story’s popularity’s hits 
attribute to be incremented by one any time the story viewed by an end user. This is useful if 
you are trying to keep track of which stories are viewed most frequently on your web site. To 
enable the hit tracking capability for a template, just include the call to trackHits() method 
on HitCountTool tool anywhere on the page (it has no visible output so won’t be seen by the 
end user).

Syntax: $HitCountTool.trackHits($Story)

Voting Tool

The VotingTool is used to enable a story template for voting. When and ACM system is 
configured a mechanism is set up that will receive an http request from the web site’s pages 
to track votes for a story. A vote submission request is composed of two components, the ID 
of the story (provided through the "$VotingTool.ObjectIDParam” tool) that is having voting 
tracked for it, and the vote value that was voted for (provided through the 
$VotingTool.ValueParam tool).

In order to enable this, you need to create a form on your template that would present the 
user with the voting selections your site uses and a button to submit the values. The voting 
tool would be used within this form to provide the appropriate names for request parameters 
that will be submitted back to the vote tracking system.
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An example would best illustrate how to use this. The following would display five radio 
buttons to allow the end user to vote on the usefulness of a story and submit it to the vote 
tracking servlet:

<IFRAME name=”hiddenFrame" style="position:absolute; left:-500; top:0; 
visibility:hidden;"></IFRAME>

<FORM NAME="Vote" target="hiddenFrame" ACTION="$VotingTool.VotingURL" 
METHOD=POST>

        <INPUT TYPE="hidden" NAME="$VotingTool.ObjectIDParam" 
VALUE="$Story.ID">

        <p><b>How useful would you rate this story (1 = least useful, 5 
= most useful)</b></p>

        #set($count = 1)

        #while($count <= 5)

            <p>&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;<input type="radio" 
name="$VotingTool.ValueParam" value="$count">$count</p>

            #set($count = $count + 1)

        #end

</FORM>

Linking Tool

The linking tool is used to dynamically create links between different objects on your web 
site. The linking tool produces a URL that you can use in your templates to allow navigation 
to other pages in the web site. The linking tool takes two parameters, the object that the link 
is to link to and the name of the template that the object will be rendered with at the 
destination of the link.

Syntax: $LinkingTool.createLink($object, 'TemplateName')

Example: $LinkingTool.createLink($Story.categories.get(0), 
‘CategoryTemplate’)
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Pagination Tool

Sometimes the lists in the system can contain very large numbers of items. When this is the 
case, you might want to break the pages up and display the results of the list across multiple 
pages. To do this, you can use the PaginationTool. To initiate pagination you pass the list 
into the $PaginationTool.paginate($ListOfObjects) function. The value 
returned from this is a sublist containing the items on the first page.

The size of the pages is set using the 
$PaginationTool.setPageSize(NumberInPage) function.

You can retrieve the current page of the pagination using the $PaginationTool. 
CurrentPageNumber function.

To create the navigation between the pages of your result you can use the 
$PaginationTool.PaginationNavigation function and iterate through its 
returned URLs using #foreach.

If you are using a Right-To-Left language, you can set the direction of the pagination using 
the 
$PaginationTool.setPaginationNavigationDirection($PaginationT
ool.RIGHTTOLEFT) function.
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An example of how to use this to display all of the headlines of a Category’s ranked stories, 
10 per page would be:

#PaginationTool.setPageSize(10)

#foreach($currentStory in 
$PaginationTool.paginate($Category.rankedStories))

$currentStory.headline<br>

#end

#foreach($pageInfo in $PaginationTool.PaginationNaviation)

#if($pageInfo.get(‘Number’) != $PaginationTool.CurrentPageNumber)

<a href=”$pageInfo.get(‘URL’)”>Page 
$pageInfo.get(‘Number’)</a>&nbsp;&nbsp;

#else

Page $pageInfo.get(‘Number’)&nbsp;&nbsp;

#end

#end

Paragraph Parser Tool

ACM provides a tool that can be used to break any string up into a list of paragraphs. This 
can be useful if you have a business rule to display an image between the second and third 
paragraphs of a story for example.

There are two functions in the parser tool, breakIntoLines which returns only the string and, 
breakIntoParagraphs, which returns the strings wrapped in <p> tag.

Syntax: $ParagraphParserTool.breakIntoLines($anyString)

Syntax: $ParagraphParserTool.breakIntoParagraphs($anyString)

Example: $ParagraphParserTool.breakIntoLines($Story.body)
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Search Tool

ACM provides a search tool which is used to retrieve objects from the ACM system in a way 
other then through the object relationships. It can do this in two ways, either retrieving an 
object directly using the object’s unique ID, or by executing a predefined search.

Each object in the ACM system has a unique ID which is accessible as an attribute of the 
object called ID. The ID is also accessible from within the ACM Broadcast application by 
clicking the  button on any object’s page.

To retrieve the object directly you would use the Search Tool’s getByID function:

Syntax: $SearchTool.getByID("SomeObjectGUID")

To retrieve a list of objects, as specified by a predefined search, you would need to invoke 
the search using the executeSearch function:

Syntax: $SearchTool.executeSearch("NameOfTheSavedSearch")

Saved searches must be created using the ACM Administration applications Object 
Manager. Follow the instructions from the Object Manager user manual for creating the 
saved search you are interested in and then follow the following steps to enable that saved 
search within the ACM Broadcast system.

1. Go to Object Manager

2. Create search that you want and save it. Give any name you want (it is not related to 
anything).

3. In quick searches panel expand ObjectManagerOSG and click on ObjectManagerSearch

4. You will see a list of all saved searches. Find the search you saved in step 2 and view it.

5. In the view you will see lots of XML for ObjectManagerCriteria field. Select all of it 
and copy to clipboard.

6. Click "Create Object" in the top menu.

7. Select project for which you are creating the search.

8. Select RenderSearch object type.

9. Paste XML from your clipboard into RenderSearchCriteria field.

10. Enter the name of the search that is referenced in template into RenderSearchName. 
This name must match what is in template in order for search in templates to work.

11. Save.
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The system also supports parameterized searches, or those whose value parameters are 
provided by the end user. In order to create a parameterized search, you need to create a 
Saved search like described above with search parameters in place of values. The syntax for 
parameter is ${ParameterName}. Than you need to create a form on your template that 
would present the user with input for each parameter that you specified in the saved search 
and a button to submit the values. The names of the input must match the names of the 
parameters in the saved search that you created.

The following example would display one input box to get a string to search for and a submit 
button.

<FORM NAME="Search" ACTION="$LinkingTool.createLink($Category, 
‘SearchResult’)" METHOD=POST>

        <INPUT TYPE="text" NAME="SearchParam" size="30">

<INPUT TYPE="submit">

</FORM>

When user clicks on submit button the page rendered by “SearchResult” template is 
rendered passing value of SearchParam that user entered. The “SearchResult” template is 
very simple. It uses the SearchTool to calls the saved search and displays results:

<BODY>

    #foreach ($story in $SearchTool.executeSearch("TestParamSearch"))

        $story.headline <br>

    #end

</BODY>

As you can see the parameters from previous page do not require additional handling on 
your part—they are just used automatically.

Render Tool

The ACM template system allows you to use one template within another template. This 
allows you create consistency within your web site and reduce the number and complexity 
of the templates you have. 

An example of when this might be useful would be to create a template for display a 
Windows Media asset, which included the player control and your station’s branding, and 
then anytime you needed to display a Windows Media asset within another template you 
would just use the Windows Media template.
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To do this you would use the RenderTool.renderInline function:

Syntax: $RenderTool.renderInline($ObjectToRender, 
"TemplateNameToRenderWith")

Example: $RenderTool.renderInline($Story.videos.get(0), 
"MyWindowsMediaTemplate")

Date Tool

The ACM template system provides a tool which can be used to format dates. There are 
hundreds of different ways to display dates and this formatting is accessible using the 
$DateTool.format function. This function takes two parameters, the date format to be used 
and the date attribute that is to be formatted.

The format tool is backed by a Java class called the SimpleDateFormatter and the 
documentation for that class indicates how to construct a format string. Please see 
http://java.sun.com/j2se/1.5.0/docs/api/java/text/SimpleDateFormat.html for details.

Syntax: $DateTool.format("dateFormatString" , dateAttribute) 

Example: $DateTool.format("yyyy-M-d H:m:s" , 
$Story.lastmodifieddate)



10 Developing Stories

The story is the focal point of Active ContentManager. ACM provides a variety of features 
that allow you to effectively create and manage stories. Some of the features include 
managing images and videos associated to the story, adding related links on the webpage, 
previewing stories and approving them for publication. 

Once stories are pushed to ACM, you can search for stories and categorize, rank, and 
approve them before they appear on your website. 

You will find the following information:

• Workflow: Creating a Story

• A Tour of the Story Tab

• Creating Content for a New Story

• Adding and Managing Associations

• Creating Custom Fields

• Previewing a Story

• Modifying a Story
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Workflow: Creating a Story

The following is a typical workflow for writing news stories from scratch.

 Step Refer to:

 Create the content for the story. “Creating Content for a New Story” on page 87

 Categorize the story and enter keywords. “Adding Categories and Keywords to the Story” 
on page 88

 Associate sources and authors. • “Adding Authors to a Story” on page 89

• “Adding Sources to a Story” on page 90

 Attach media to the story. “Adding Media to the Story” on page 91

 If you are recording on-air video, set its 
duration.

“Associating a Video Recording” on page 93

 Add or create links. “Creating a Link in a Story” on page 92

 Preview the story. “Previewing a Story” on page 95

 Approve the story. “Approving Stories” on page 100
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A Tour of the Story Tab

Before you begin creating or writing a story, it is important to familiarize yourself with the 
properties of the Story tab interface. When you start creating a story, the default page 
displays the following:

n If the story has been pushed from Avid iNEWS, then certain sections will be populated with 
the appropriate information.

The Content Tab

This is where you write the story. It is mandatory to include a story headline. You can 
customize the text using the editing buttons available at the top of each text box.

Story’s title Editing buttons

Entire story



10  Developing Stories

86

The Associations Tab

Associating the news story with an image or video not only makes it interesting but it also 
contextualizes its subject. You can also attach relevant links, credit the news source and the 
author responsible for the story. You must associate at least one author with the story. The 
list of potential authors comes from the list of users in a project. 

You can also add categories and keywords. If you want to group the new story in a category 
that does not exist, you can create it here as well. You can also remove the story from 
categories. 

Note that a Journalist cannot create new categories or delete old ones. If you are a Journalist 
and you need a new category for your story, inform your Webmaster or Editor. 

If, for example, you have more than one source or author for a given story and you want to 
change the order in which they will appear in the news story, use the Move Up and Move 
Down buttons.

Supported image formats

Enter links associated to the story. Previews images or videos

Supported video formatsMove Up and Move Down buttons to 
reorder the referencing of the objects

All other types of assets and 
non- supported images and video



Creating Content for a New Story

87

The Custom Tab

This tab displays the custom fields that have been created for the project. To create custom 
fields, see “Creating Custom Fields” on page 94.

The Feedback Tab

The feedback tab displays the hits that track the traffic of that story on the website or a 
voting from web users. 

The Webmaster can clear the hits and votes using the appropriate links on the Feedback tab.

n For each template the user wants feedback for the story, the appropriate tags must be added 
in the template—see “ACM Template Syntax” on page 69.

Creating Content for a New Story

By default, the Story tab is selected after login and the Search for News Stories page is 
loaded. You can create the news story, run a spell check, and format it like any text 
document.

To create a new story:

1. Select the Story tab.

2. Click Create.

3. Type the following:

- A headline for the story

- A subheadline, if applicable

- An abstract, which is generally a summary of the story

- The body

4. Do one of the following:

- Click the Create button to save the story.

- Click the Create and Edit button to save the story and open it for continued 
editing.
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Adding and Managing Associations

Associations refer to authors, categories, sources, media, links, and keywords. There are 
several tasks you can do to streamline your workflow when working on many stories and 
projects. These include creating new authors or categories beforehand so that the 
information is readily available for the Journalist. You can also clean up associations that are 
no longer needed in a project.

Adding Categories and Keywords to the Story

As part of creating the story, you should categorize it and add any applicable keywords. If 
you are a Journalist and the category you would like to use is not available, ask the 
Webmaster or Editor to create the categories.

To add categories and keywords:

1. Go to Story > Create.

2. Click the Associations tab.

3. In the Categories section, click Add.

4. In the window that appears, select a category and click Add.

You can add as many categories as needed. Simply Ctrl + Click multiple selections.

5. In the Keywords section, enter a keyword for the story and press Enter

You can add as many keywords as needed.

The selected categories and keywords will appear in their respective text fields.

For more information, see “Working with Categories” on page 47.

Creating a List of Authors

Authors are responsible for writing and developing the content of a story. The author can be 
the owner of the story, can edit it, and can post it to the web. A story may contain more than 
one author and they can be ranked and accessed in a particular order in a template. 

Creating authors is a task only done by the Webmaster. It is similar to creating users.

To create an Author:

1. Go to Story > Create > Associations. 

2. In the Authors section, click Create.

By default, the Authors section displays only the current user’s name.

The Create a New User window opens.
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3. Fill in all required information from User name to the Role—see “Creating a New User” 
on page 37

4. Select the credit from the drop-down list or none.

5. Click Create. 

The author and credit are added to the Authors section on the Associations page.

Adding Authors to a Story

Once an author has been created, you can assign a credit for each author. Make sure that the 
credit text you want to use exists. If it is not available, you must create it—see “Building a 
List of Credits” on page 43.

When creating a story, the author’s name is required. By default, the name of the user logged 
in appears in the Authors field. If you are not involved with the story, you can manually 
remove this association.

To add Authors to a story:

1. Go to Story > Create > Associations. 

2. In the Authors section, click Add.

The Add Authors window is displayed.

3. Select a Credit from the drop-down list.
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4. Select the Author from the Authors drop-down list.

5. Click the Add Author button

The credit and the author are displayed in the box as they would appear in the story.

6. Click Add.

The author and credit are added to the Authors section on the Associations page.

Adding Sources to a Story

Any ACM user can add the sources of the story.

To add a source to a story: 

1. Click the Add link above the Source section. 

The Add Source to Story window appears.
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2. Select the source from the list and click Add.

The window closes, and the source appears in the Sources section.

3. Repeat to add more sources.

Adding Media to the Story

You can add media such as images and video to the story. A Journalist can only add media to 
the story if they exist in the database. If you are a Journalist and the media you want to use is 
not listed, ask the Webmaster or Editor to create them.

You can use the Preview window to preview your images and video.

For a list of supported media, see “Media Formats Supported” on page 56.

To add media:

1. Go to Story > Create > Associations.

2. To add media, click the Add link above the Images, Videos, or Other Assets sections.

The Search for New Assets window opens.

3. Fill out the fields provided to fine the media you want to add and click the Search 
button.
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4. When the results appear in the window, click the Select to Add check box of the asset 
you want to add.

5. Click Add located at the bottom-left of the window.

The window closes and the asset name(s) appears in the respective list.

6. Click Create (or Save if modifying an existing story) to save the added asset(s) to your 
new story.

Creating a Link in a Story

Links may be added to or deleted from stories, and a story may contain more than one link, 
all of which can be ordered. You can set the order in which they are accessed in a template.

There are two types of links: 

• A link to another story inside your website

• A link to an external URL

To create a link in one story to another story:

1. Go to Story > Create > Associations. 

2. Click Add Story, located above the Link field.

3. In the Search for News Story window that appears, locate the story to which you want to 
link. You can search by headline, category, or date.

Only approved stories will be displayed.

4. Click the Select check box for the story to which you want to click.

5. Click Add, located at the bottom of the window.

The headline of the selected story or stories will appear in the Links text field.

To create a link in one story to an external URL:

1. Create the story in which you want to add the link. 

2. Click the Create link, located above the Link text field.

The Create a New Link window opens:



Adding and Managing Associations

93

3. Type the name of the link you want to create.

4. Type the address of the URL to which you want to link. 

You must use the complete URL including the http:// prefix. If the protocol is not 
present the link will fail.

5. Click Create (or Save if modifying an existing story) to save the added link to your new 
story.

The window closes, and the name of the external website appears in the Link text field.

Associating a Video Recording

When creating a story from scratch, you can set up or configure a recorder to capture a video 
segment. For more information about recorders, see “Using Recorders” on page 31.

If a recorder has already been scheduled to record an on-air video, then this section will be 
autofilled. Only make changes if you need to nudge the recording start time or duration. 

To set up the on-air video recording:

1. Go to Story > Create > Associations. 

2. Click Set Video.

The Search for News Assets window opens. This search window is limited to searching 
recordings only.

3. Run a search using one or more of the criteria—see “Searching for Assets” on page 59.

4. Click Search.

When the search results are displayed, click the thumbnail to preview the material that 
you want to associate.

You can click the Expand button to run another search.

5. In the On-air video section, enter the video segment start time using the syntax shown.
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6. Enter the duration for the segment.

7. Click Close Window.

Removing Associations

You can remove categories, keywords, links, media, authors, a recording, or sources from 
the story you are working on. Removing any of these from a story does not delete them from 
the system.

Before you begin, make sure you are in the Associations tab.

To remove an association from a story:

1. Go to the section of the asset you want to remove.

2. Select the association, for example Reuters in the Source section, and click Remove.

3. Click Save to save your modifications to the story.

Creating Custom Fields

ACM provides the ability to create and add custom fields for a story obect. For example, if 
your website allows user submissions such as photographs, you can add a custom fields for 
the name, email address, and description of the photo.

To create a custom field:

1. Go to Story > Manage Custom Fields.

2. Click Add New Custom Field.

3. Enter a name for the custom field.

4. If you want to be able to search for the field in the database, select Full text searchable.

5. Enter the number of rows for this field. 
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6. Click Add.

The custom field is now added and displayed in the Custom tab for the story.

Previewing a Story

It is a good idea to preview a story after before approving it for web publication by using an 
imported template.

n You must always save your story before previewing it to see the changes.

Previewing Stories using a Template

You can preview a story or an entire category through any template that you have imported.

To preview stories using imported templates:

1. In the Story tab, make sure you are on the Search page.

2. Run a search to find the story you want to preview.

3. Click the link to the story.

The story is loaded in the Modify an Existing Story page.
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4. Select a template from the drop-down list at the bottom of the page.

5. Click Preview.

To preview stories using imported templates from the category view:

1. In the Category tab, click Modify.

2. Select the category you want to modify.
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3. Select a template from the drop-down list at the bottom of the page.

4. Click Preview.

Modifying a Story

You can modify any part of the story from its content to its associations. This is usually the 
case when a story has been created in Avid iNEWS or Avid NewsCutter to be used in a news 
broadcast and you want to use the same story on your news website. The story may contain 
assets such as audio, video, and graphics. The Journalist can edit and repurpose the story for 
web delivery using ACM. You may want to add items such as links and authors names, 
change headlines, subheadlines, or the abstract. If the received story was in the form of a 
script, you can add images, video, or any other assets that will complete it and make it 
interesting to the web user.

You also have the option to apply a template to the story and preview it in the display format 
that will be used on the website or a mobile device such as mobile phone or a BlackBerry.

After you have performed a search and found the story you want, you can go ahead and 
make the modifications. You can also run a spell check through your entire story. 

To modify a story:

1. Edit the information in the various fields as needed—see “A Tour of the Story Tab” on 
page 85.

2. Click Save.

You can return to the Search page or save the modifications and then return to the Search 
page by clicking the Return to Search and Save & Return to Search buttons respectively.

3. Optional: Preview the story with a template using a template from the drop-down list.

n You must save your story before previewing it to see the changes.
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To spell check a story:

1. Click the Spell Check button available from the Headline, Subheadline, Abstract, and 
Story sections.

If the text contains no misspelled words, you will get a message. But if errors were found, 
you will be prompted to correct the spelling or ignore the word.

Locking a Story

Whenever a story is being edited, it is automatically locked, meaning no one else can edit the 
story until it is unlocked. Opening a story does not lock the story. It is locked by the first user 
to make an edit, such as typing a character or selecting an image. If you attempt to edit the 
same story, you will get a message that it is locked. However, you will be able to read locked 
stories.

ACM notifies others about locked stories in a variety of ways. For instance, when the user 
locks a story, a padlock icon appears in the upper right corner of the screen, along with the 
user name, date, and time.

n A Webmaster can unlock a locked story by opening the story and clicking Unlock.

When you run a search for a story, the Search Results list contains a column with colored 
padlock icons to indicate which stories are locked, and by whom.

A green padlock indicates that you locked the story.

A red padlock indicates that another user locked the story. Mouse over the icon to see who 
locked the story.
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Searching and Loading a Story

You can search for stories by performing a text or category search or by using a range of 
dates. 

Search results appear in a spreadsheet style format with information such as the story’s rank, 
the headline (first 25 characters), the author(s), and whether the story is locked.

n If you are conducting a search from the Link section on the Associations page, the results 
will only contain approved stories.

To search for a story:

1. Click the Story tab.

2. On the search page, search for a story using one of the criteria:

The stories are displayed.

3. Select the story you want to load.

n If you are searching for a story to add as a link, use the Add Story link above the Link section 
of the Associations page—see “Creating a Link in a Story” on page 92.

Filters Description

Text Enter a word that may appear in the headline, abstract or both.

Category Select a category from the drop-down list. 

The results will display stories in ranked order first, followed by 
unranked in order of last modified date.

Last Modified Date Select a date range from the drop-down list. 
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Approving Stories

Approving a story means that it has the potential to be published on the web. It is a good idea 
to preview the story using the associated template before approving it. 

Only the Webmaster and Editor can approve and unapprove stories. Journalists can view an 
approved story but cannot modify it. If you are a Journalist, you cannot add, create, or delete 
links, categories, or media assets. If you need to make a change, see the Webmaster or your 
Editor. 

Unapproved stories cannot be used as links within other stories; therefore, they will not 
appear in the Search Results list when a user searches for a story to add as a link. Similarly, 
if a story being used as a link within another story is unapproved, it will no longer appear in 
the other story’s list of links. When an approved and ranked story in a category is 
unapproved, its ranking is lost and any scheduled tasks will be deleted. After approving a 
story, you can rank it within a category—see “Ranking Stories” on page 51.

n A story transferred from Avid iNEWS is not automatically approved. It must be approved by 
the Webmaster or the Editor.

To approve or unapprove a story:

1. Search and load the appropriate story.

2. Select the Approved check box or deselect it to unapprove.

3. Click Save.

4. Optional: You can schedule a story for ranking—“Scheduling a Story for Ranking” on 
page 53.

Deleting a Story

When a story is no longer needed, it can be deleted by a Webmasters and Editors.

Only unapproved stories can be deleted. If an approved story must be deleted, remove its 
approval status before deleting it.

To delete a story:

1. Search and load the story you want to delete.

2. Click the Trash button. When prompted with confirmation message, click OK. 



11 Weather

Active ContentManager lets you create and display weather forecasts.

You will find the following information:

• Forecast

• Extended Forecast

• Weather Categories

• Weather Templates
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Forecast 

The Forecast link displays a Calendar view. 

When a template referring to Today’s Forecast is rendered, it displays the forecast for the 
current day. Located at the top of the Calendar view is the name of the month and year. To 
the left of the name is a << button. when this button is clicked, the Calendar view displays 
the previous month. To the right of the year is a >> button. Clicking this button advances the 
Calendar view to the next month.

In the previous graphic, the Current Day is the first enabled day on the calendar (white 
background). Each enabled day on the Calendar view has a status image associated with it. 
Placing the mouse over the image on the calendar displays the description of the image. 
Mousing over the word LEGEND located at the top-right of the calendar also displays 
descriptions of each status image.
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The Current Day does not advance to the next day at midnight in case the next day's forecast 
is not set. Instead, the current day advances only when the user clicks the Current Day>> 
button, located on the lower right of the calendar view. The current day can only be 
advanced when the forecast for the next day has been set. The Current Day>> button will 
remain disabled until the forecast is set. When the Current Day>> button is clicked, the next 
day's forecast becomes Today's Forecast and the next day will become the Current Day.

The Calendar view also has a <<Current Day button located on the lower left of the Calendar 
view. It is used to decrement the Current Day. When clicked, this button makes the previous 
day's forecast become Today's Forecast and the previous day will become the Current Day. 
The <<Current Day button will remain disable until a forecast for the previous day has been 
set.

If there are no forecasts in the system, the current day defaults to today.

n Only one day's forecast previous to the current day's forecast will be stored in the system. 
Once the current day is advanced, the forecast for two days before the current day will be 
lost.

Located at the bottom of the Weather Calendar is a Preview button.

Selecting a template and then clicking the preview button opens an additional window that 
displays a preview of the entire Weather Category.
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Setting Today’s Forecast

To set Today’s Forecast:

1. Log in to Active ContentManager. 

2. Click the Weather Tab. The Weather Calendar view is displayed.

3. Click the current day to display the Forecast view.

In this view, information regarding Today’s Forecast is specified. An asterisk (*) next to 
a text field indicates that this information is required. The following table explains the 
text fields, whether or not it is a required fields, and the type of value

.

Text Field Required Value

Today’s High YES This value represents the high temperature 
for today’s forecast. This must be a 
numeric value.

Today’s Low YES This value represents the low temperature 
for Today’s Forecast. This must be a 
numeric value.



Forecast

105

4. Enter the required forecast information in each text box

5. Enter non-required forecast information if desired.

6. Do one of the following:

- Click the Save Forecast button to save Today’s forecast.

- Click the Save & Next Day button to save Today’s Forecast and display the next 
day’s Forecast view

- Select a template and Click the Preview button to preview the completed Forecast.

Today’s PoP NO This value represents the Probably of 
Precipitation (PoP) for Today’s Forecast. 
This must be a numeric value

Forecast Summary NO This is a summary of Today’s Forecast. It is 
in text format and may contain alpha and 
numeric characters.

Full Forecast YES This is Today’s complete Forecast. It is in 
text format and may contain alpha and 
numeric characters.

Sunrise NO This is Today’s Time of Sunrise. It is in text 
format and may contain alpha and numeric 
characters.

Sunset NO This is Today’s time of sunset. It is in text 
format and may contain alpha and numeric 
characters.

Tonight’s Summary NO This is a summary of Tonight’s Forecast. It 
is in text format and may contain alpha and 
numeric characters.

Tonight’s Forecast NO This is Tonight’s complete Forecast. It is in 
text format and may contain alpha and 
numeric characters

Forecaster(s) YES This is the name of the Forecaster. At least 
one name is required in this field. 

Text Field Required Value



11  Weather

106

Setting Forecast Images

All weather forecasts (Forecast Days and the Extended Forecast) may contain images. A 
Forecast Day may include up to two images: Today's Forecast image and Tonight’s Forecast 
image. An Extended Forecast may contain one image. All images must be formats supported 
by Active ContentManager (png, gif, jpg). 

There are two ways to include an image in a forecast. The user may choose an image from a 
list of standard weather images previously imported into the system or import a single use 
image to include in a forecast.

Weather images that are imported are added to the standard images for future use.

To choose a Standard Weather image for Today’s Forecast:

1. Log in to Active ContentManager. 

2. Click the Weather Tab. The Weather Calendar view is displayed.

3. Click the current day to display the Forecast view. 

4. Enter the required forecast information in each text box

5. Enter non-required forecast information, if desired.

6. Click Choose Image.

A window opens displaying all of the available weather images currently in the weather 
asset category.
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These images were previously imported into the system as any other image asset, except 
they were specified as Weather Images on the asset creation page. Weather Images are 
the only images that will be available when pressing the Choose Image button. 

7. Click the Select button corresponding to the image desired for Today’s Forecast. The 
image is displayed in the Weather Forecast window.

8. Do one of the following:

- Choose or import an Image for Tonight’s Forecast.

- Click the Save Forecast button to save Today’s forecast.

- Click the Save & Next Day button to save Today’s Forecast and display the next 
day’s Forecast view

- Select a template and Click the Preview button to preview the completed Forecast.

To choose a Standard Weather image for Tonight’s Forecast:

1. Log in to Active ContentManager. 

2. Click the Weather Tab. The Weather Calendar view is displayed.

3. Click the current day to display the Forecast view. 

4. Enter the required forecast information in each text box

5. Enter non-required forecast information, if desired.

6. Click the Choose Image button next to the Tonight’s Forecast image text box

A window opens displaying all of the available weather images currently in the weather 
asset category.

These images were previously imported into the system as any other image asset, except 
they were specified as Weather Images on the asset creation page. Weather Images are 
the only images that will be available when pressing the Choose Image button. 

7. Click the Select button corresponding to the image desired for Tonight’s Forecast. The 
image is displayed in the Weather Forecast window.
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8. Do one of the following:

- Click the Save Forecast button to save Today’s forecast.

- Click the Save & Next Day button to save Today’s Forecast and display the next 
day’s Forecast view

- Select a template and Click the Preview button to preview the completed Forecast.

To import a Weather image for Today’s Forecast:

1. Log in to Active ContentManager. 

2. Click the Weather Tab. The Weather Calendar view is displayed.

3. Click the current day to display the Forecast view. 

4. Enter the required forecast information in each text box

5. Enter non-required forecast information, if desired.

6. Click the Import Image button next to the Today’s Forecast image text box.

A window appears, allowing the user to import a single-use image to associate with the 
forecast. This method is ideal for images which are only relevant for a particular day. 
The image may still be modified or deleted as with any other asset, but the image will 
also be deleted as soon as no forecast refers to it. This may happen when:

• A new image is imported that overwrites the old one, the old one will be 
removed from the system

• The Current Day>> button is clicked, on the calendar view, incrementing such 
that the forecast is then two days before the current day. The forecast and its 
imported images are deleted.

• The <<Current Day button is clicked, on the calendar view moving the forecast 
beyond the range of the Extended Forecast Days. The forecast and its imported 
images are deleted.

The only exception is when any other Forecast or News Story refers to the image. In this 
case it will not be deleted.
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7. Enter a name for the image in the Image Name text box.

8. Do one of the following:

- Enter the file image path.

- Click the Browse button to browse to the file image.

9. Click the Import button. The window closes and the file is imported to the image text 
box.

To import a weather image for tonight’s Forecast:

1. Log in to Active ContentManager. 

2. Click the Weather Tab. The Weather Calendar view is displayed.

3. Click the current day to display the Forecast view. 

4. Enter the required forecast information in each text box

5. Enter non-required forecast information, if desired.

6. Click the Import Image button next to the Tonight’s Forecast image text box.

A window appears, allowing the user to import a single-use image to associate with the 
forecast. This method is ideal for images which are only relevant for a particular day. 
The image may still be modified or deleted as with any other asset, but the image will 
also be deleted as soon as no forecast refers to it. This may happen when:

• A new image is imported that overwrites the old one, the old one will be 
removed from the system

• The Current Day>> button is clicked, on the calendar view, incrementing such 
that the forecast is then two days before the current day. The forecast and its 
imported images are deleted.
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• The <<Current Day button is clicked, on the calendar view moving the forecast 
beyond the range of the Extended Forecast Days. The forecast and its imported 
images are deleted.

The only exception is when any other Forecast or News Story refers to the image. In this 
case it will not be deleted.

7. Enter a name for the image in the Image Name text box.

8. Do one of the following:

- Enter the file image path.

- Click the Browse button to browse to the file image.

9. Click the Import button. The window closes and the file is imported to the image text 
box.

Setting the Forecaster(s)

Setting the Forecaster is similar to adding credits and authors to a story—see “Adding Media 
to the Story” on page 91 A Forecaster is an AuthorCredit, the a pairing of a 
CreditObject—Written By or Edited By or Posted By—and an AuthorObject. For Instance, 
Written By: Jo. You may have an AuthorCredit with no credit—as shown in the following 
graphic—but you may not have a AuthorCredit without an author. One AuthorCredit object 
is required for every story or forecast. The user’s name creating the Forecast or Extended 
Forecast is added to the Forecaster(s) list by default with no Credit associated with the 
Author— as shown in the graphic below. A Forecast may contain more than one 
AuthorCredit all of which are ordered. AuthorCredits are accessed in a particular order in a 
template. For information on the way in which AuthorCredits are accessed in the templates, 
contact your Webmaster. You may set that order in the Forecaster(s) section.

To add a Forecaster:

1. Navigate to the Forecaster(s) section.

2. Click the Add button. The following window appears:

3. Select a credit from the Credits drop-down list or (none) for no credit to appear with the 
author.

4. Select an author from the Authors drop-down list. 

5. Click the Add Author button located to the right of the Authors list. The author and 
credit are added to a list pending addition to the forecast.

Multiple authors and credits may be added by repeating steps 3-.

6. Click Add, located in the lower left corner of the window. The window closes and the 
Author(s) and Credit(s) appear in the forecaster(s) text field.
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To create Forecaster(s):

1. Navigate to the Forecaster(s) section.

2. Click the Create button. The following window appears:

3. Fill in all required information.

4. Click the Create link located at the lower left of the window to add the new user to the 
Forecaster(s) section.

To remove Forecaster(s):

1. Navigate to the Forecaster(s) section.

2. Select the Forecaster you want to remove.

3. Click the Remove link located at the top of the section.

To re-order the Forecasters:

1. Navigate to the Forecaster(s) section.

2. Select a Forecaster to move.

3. Click the Up or Down arrow to move the forecaster up or down in the order.

Extended Forecast

Forecasting styles may vary so there are two different ways to specify an Extended Forecast:

• Clicking the Extended link on the Weather page

• Clicking a date after the current day.

Setting the Extended Forecast

Clicking the Extended link on the Weather page, allows the user to set the Extended 
Forecast. This forecast represents a single Extended Forecast that may be modified as often 
as need be. Templates may refer to this object and will not have to be changed since it is 
always the same NewsWeatherExtendedForecast object type that is being updated.

You may also set the Extended Forecast by clicking any available day after the current day 
on the Calendar view. You may not set a forecast until the previous day’s forecast is set, and 
you may not set any extended forecasts until the current day’s forecast is up-to-date. 
Templates may refer to the list of Extended Forecast Days – the first Forecast in this list will 
be tomorrow, the second will be the day after tomorrow, and so on. Extended Forecast Days 
advance by one day when the user clicks the Current Day >> button on the Calendar page. 
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Although users may access up to 9 extended forecast days, the number of extended days 
rendered is determined by the templates associated with them. Values for an Extended 
Forecast Day are set the same way as Today’s Forecast, using the Forecast view.

To set the extended Forecast using the Extended link:

1. Log in to Active ContentManager. 

2. Click the Weather Tab. The Weather Calendar view is displayed.

3. Click the Extended link. The Extended Forecast view is displayed.

4. Enter the required forecast information in each text box

5. Enter non-required forecast information, if desired.

For information about setting the forecasters and adding images, see “Setting the 
Forecaster(s)” on page 110 and “Setting Forecast Images” on page 106.

Weather Categories

All Weather forecasts are stored as part of the WeatherCategory. This category contains the 
following:

• Today’s Forecast 

• Extended Forecast 

• Extended Forecast Days
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Each Project may have only one WeatherCategory. When creating templates, all weather 
forecasts should be accessed through this category. The Calendar view includes the 
functionality to preview the entire WeatherCategory by selecting a WeatherCategory 
template and clicking the Preview button.

For instance, to render Today’s Forecast, creating a static object tag that points to a particular 
object is unwise because after the current day is advanced, this tag will point to yesterday’s 
forecast. If the user creates a template that references the “Today’s Forecast” property of the 
WeatherCategory, the template will always point to the correct forecast.For more 
information about Categories, see “Working with Categories” on page 47.

Weather Templates

Today’s Forecast and the Extended Forecast Days are all NewsWeatherForecast objects and 
can use the same template. The Extended Forecast is different. This forecast uses the 
NewsWeatherExtendedForecast object Type. Avid recommends using the 
NewsWeatherCategory object type as a starting point for rendering all Weather Forecasts.
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